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Step-by-Step introduction to Simulating Dynamic and Equilibrium Behavior 

on the example of  alanine zwitterions salvation. 
 

This Lab further explores HyperChem’s molecular mechanics functionality, 

and demonstrates how to use molecular dynamics with HyperChem.  

Using the AMBER force field you will optimize an alanine zwitterions in 

both isolation and solution to determine the effect of solvent on the optimal 

structure. You will also perform molecular dynamics in solution to simulate 

the behavior of this species in biological systems 

 

This Lab has 5 sections: 

In section 1, you will create an optimized alanine zwitterion. 

In section 2, you will use a molecular solvent model with periodic boundary 

conditions to solvate the zwitterion. 

In section 3, you will learn how to superpose molecular structures on each 

other to visually compare the isolated molecule and the solvated molecule. 

In section 4, you will use molecular dynamics to anneal the system to obtain 

a lower energy minimum. 

In section 5, you will use Langevin dynamics to simulate the presence of a 

solvent during annealing, and Monte Carlo to sample configurations from a 

Boltzmann-weighted distribution. 

Advanced exercise- playback dynamics 

 

 

Section 1 

 

Creating the Isolated Alanine Zwitterion and measuring it 

properties 

 
a. Sketching the Alanine Zwitterion 

Although you could easily use the HyperChem amino acid library to display 

alanine, as a practice exercise you will build it from scratch, using the 

chemical formula:            C'O2-CH-NH3 

                                                   | 

                                                  CH3 

Before drawing: 

Turn on Allow Arbitrary Valence and Explicit hydrogens in Built menu  

Turn off Show Aromatic Rings as Circles in the Display menu.   
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b. Assigning Atomic Charges 

The next step is to place charges on some atoms to approximately represent 

the charge distribution in the zwitterion.  

In this exercise, you make a simple approximation of a charge of +1.0 on the 

nitrogen atom and charges of –0.5 on the oxygens (why?). In order to do this 

you need to assign nonzero values for the charges on these three atoms. 

 
To assign atomic charges: 
1. Get into selection mode and set the select level to atoms. 

2. Select the nitrogen atom. 

3. Choose Set Charge on the Build menu and assign a charge of +1. 

4. R-click in an empty area to clear the selection. 

5. Select both oxygen atoms and assign a charge of –0.5. 

This sets a charge of –0.5 for each of the oxygen atoms. 

6. R-click in an empty area to deselect the atoms. 

 

c. Choosing the Force Field 

The next step is to choose a force field. You should choose a force field 

before you invoke the Model Builder because the Model Builder assigns 

atom types to each atom according to the force field that you specify. 

Alternatively, you could explicitly assign atom types any time by using 

Calculate Types on the Build menu. 

 

To choose the force field: 
1. Select Molecular Mechanics on the Setup menu. 

The Molecular Mechanics Force Field dialog box opens. 
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2. Select AMBER, then L-click on Options. 

The Force Field Options dialog box opens. 

3. Use the following default values, then choose OK. 

 
 

d. Building, Exploring and calculating the alanine zwitterion properties 

1. Using the Model Builder build and display a first approximation of the 

alanine zwitterion. 

2. Rotate and translate the structure to look at its conformation. 

 
 

3. Open the Labels dialog box from the Display menu and choose Chirality 
for atoms.  If the central carbon is labelled R rather than S, then switch to the 

drawing tool, hold down the [Shift] key and click on the central carbon. 

You can use [Shift]+L-click with the drawing tool to rotate two neighbors, 

thus changing chirality.  

You can also draw wedges to specify conformation or chirality.  

4. Measure and report main geometry parameters (the planar O-C’-O angle, 

the O-C’-C -N torsion angle, and the bound lengths).  

5. Save the structure as ala_vac.hin. 
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e. Performing a Single Point Calculation 

Now, perform a single point calculation to compute the energy. Report the 

Energy value, the gradient and the geometry.  

The large energy and gradient indicate that the model-built structure is far 

from optimal. The principal strain is due to the C-N and C-O distances. 

 

f. Optimizing the Isolated Molecule 

1. Perform geometry optimization, using following parameters in the 

Molecular Mechanics Optimization dialog box: 

 

 
 

2. What are the optimal geometry, energy, gradient? 

Report all the calculated values. 

Which parameters changed the most? 

Later in this lesson, you use the N-C -C’-O angle to demonstrate molecular 

dynamics features of HyperChem, so save this angle as a named selection. 

3. With the angle still selected, choose Name Selection on the Select 

menu. 

 •Select Other, enter ncco, then choose OK (you may choose the second 

NCCO torsion and save it as nooc_2). 
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4. Save the optimized isolated alanine structure as ala_vac_opt.hin file so 

that you can compare it with the solvated structure you create next. 

 

 

Section 2 

 
Solvating the Structure 

HyperChem lets you place a molecular system in a box of water molecules 

with periodic boundary conditions to simulate behavior in aqueous solution, 

as in a biological system. In this part of the project, you solvate the alanine 

zwitterions you created in such model water. 

 
a. Before you continue, follow these steps: 
1. Remove labels from the display by using the default settings in the Labels 

dialog box. 

2. Choose Periodic Box on the Setup menu to open the Periodic Box 

Options dialog box. 

 

 
 

b. Setting up Periodic Boundary Conditions 
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To solvate a system with HyperChem you specify a rectangular box or cube 

of equilibrated water molecules. You define the dimensions of the box, place 

the solute in the center, and define the minimum distance between the 

solvent and solute atoms. HyperChem eliminates all water molecules with 

atoms that come closer to a solute atom than the specified distance. 

 

Specifying the Periodic Box Size 

There are several factors to consider when you define the size of the periodic 

box. Most importantly, it must be large enough to accommodate the solute. 

To take care of that look up the parameter Smallest box enclosing solute 
(this box is called the reference cube), appears automatically in the Periodic 

Box Options dialog box. 

In addition, the solute should not see its image in the next box. Box 

dimensions at least twice the largest solute dimension avoid solute-solute 

interactions when using the default cutoffs. A smaller box can be used if the 

cutoff radius that controls the range of the solute potential is made smaller. 

(so that the largest solute dimension plus the cutoff radius and range is less 

than the smallest box dimension). The standard reference cube of water is 

formed from an equilibrated cube of 18.70136Å and its nearest images, so 

you shouldn’t use dimensions larger than 56.10408Å. Dimensions that are 

multiples of 18.70136Å minimize initial bad contacts. 

 
To choose the periodic box size: 
1. Specify a box size of 12.0 by 10.0 by 12.0 Ångstroms, as shown in the 

following illustration. 

 

 
 

2. Choose OK. 

This places the structure in the center of the box surrounded by 40 water 

molecules. 
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Note: Because the orientations of the water molecules in the box are not 

symmetrical, you may end up with fewer than 40 water molecules after the 

ones that are too close to your structure are deleted. If this happens, the 

results that you get from calculations may not be quite the same as those 

given in this lesson. This will depend on how your structure is oriented 

before you solvate it. 

 

c. Displaying the Solvated System 

1. Choose Rendering on the Display menu. 

2. Turn on Perspective in the Vector and Line Options dialog box 

3. Set the select level to Molecules. 

4. Select a bond or atom of the alanine molecule, and rotate the whole 

system to look like this: 

 
 

 

d. Adjusting Cutoffs and Dielectric Options 

When you use periodic boundary conditions, you need to check the options 

for cutoffs and dielectric in the Force Field Options dialog box. 

 
 
To check the options for cutoffs and dielectric: 
1. Choose Molecular Mechanics on the Setup menu. 

2. Choose Options to open the Force Field Options dialog box. 

3. Look at the Cutoffs options at the right of the dialog box. 

When you choose the Periodic box menu option, HyperChem automatically 

changes the options for cutoffs to Inner and Outer options, which are more 

appropriate for the solvated system with the nearest-image periodic 

boundary conditions. The Outer cutoff is set to one-half of the smallest box 
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dimension, and the Inner cutoff is set to 4Å less to ensure that there are no 

discontinuities in the potential surface. 

4. Now look at options for Dielectric, which are at the top of the dialog box. 

When you use explicit solvent, you should use a constant dielectric. 

5. Select Constant instead of Distance dependent. 

Note: The dielectric constant is not automatically changed because the new 

setting is stored in the chem.ini file. 

6. Choose OK to close the Force Field Options dialog box. 

7. Choose OK to close the Molecular Mechanics Force Field dialog box. 

The Force Field Options dialog box should look like: 

 

 
 

e. Optimizing the Solvated Molecule 

The next step is to optimize the solvated system using the chosen periodic 

boundary conditions. Since the alanine molecule was set in its optimum 

(isolated state) geometry, the optimization primarily relaxes the solvent, but 

also, to some extent, the alanine is changed. Changes in alanine reflect the 

differences between the structures of a single isolated alanine molecule and 

the same molecule in solution. 

 

To optimize the molecule in solution: 

1. Get into selection mode and R-click in an empty area to deselect the 

alanine. When there is an active selection, an optimization is performed on 

the selection only. Therefore if you started the optimization with alanine 

selected, only the position of the alanine atoms is allowed to change and the 

water molecules are constrained. To optimize the complete system and allow 

reorganization of the solvent structure in the presence of alanine, you must 

clear the selection. 

2. Using Geometry Optimization on the Compute menu, start the 

optimization of the solvated alanine, including the water molecules. (Set the 
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Molecular Mechanics Optimization parameters as in step 1.). If the 

calculation hasn't converged, increase the number of maximum cycles in the 

Molecular Mechanics diagonal box to 800 and perform the calculation again. 

3. When the calculation finishes, report the energy and gradient values, 

which appear on the status line. 

 

The optimized structure for the solvated system might only be a local 

minimum. In a system with many degrees of freedom, such as this one, there 

might be many minima and it can be very difficult to locate the global 

minimum. When there are enough degrees of freedom, it is possible that any 

single static conformation is insignificant, and that only a statistical 

treatment of many low-energy conformations is appropriate. 

4. Save the structure as ala_sol_opt.hin. 

 

 

Section 3 

 
Superposition 

The system currently displayed is a minimized structure for the alanine 

zwitterion in water. It is instructive to compare the structure with the 

corresponding isolated optimized structure. Instead of comparing the 

molecules by measuring individual structural properties, you use 

HyperChem’s superposition feature to visually compare the two structures 

by superimposing. 

 

Deleting the Water Molecules 

Before superposing, delete the water molecules from the isolated structure. 

 
a. To delete the water molecules: 
1. Get into selection mode and set the select level to Molecules. 

2. L-click on the alanine. This selects the alanine. 
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3. Choose Complement Selection from the Selection menu. This selects 

only the water molecules. 

4. Choose Clear on the Edit menu. 

5. If a dialog box appears asking if you want to delete the selected atoms, 

choose Yes.  

6. Choose Show Periodic box in Display menu so that it is not set and 

only the alanine molecule is shown. 

7. Save the file as ala_sol_opt_NoSol.hin . 

Measure and report the geometry parameters, the energy, and the gradient. 

 

b. Merging the Two Systems 

The next step is to merge this structure with the isolated structure. 

Before you merge the two systems, you should select the current system so 

that you can distinguish it on the workspace after the merge. 

 
To merge the two systems: 
1. Select the alanine. 

2. Choose Name Selection on the Select menu and save the selection as 

solvated. This makes it convenient for you to display this selection later if 

you want to recover it. 

3. Choose Merge on the File menu and open ala-gas.hin. Both the isolated 

and the solvated structures should now be on screen. The solvated structure 

should still be selected. 
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Merge lets you combine the current system and another system that has been 

stored in a file. This union becomes the current system. 

4. If necessary, use the Translation tool with the right mouse button until 

both structures are in full view. At this point, use labels and color to 

differentiate the molecules. 

5. Color the selected solvated structure (Display->Color Atoms) yellow and 

label the molecule by symbol. 

Note: If Thick line is not being used as the Selection option in the 

Preferences dialog box, the solvated structure does not appear yellow until it 

is deselected. 

6. Choose Complement Selection on the Select menu. The solvated 

system is deselected and the isolated alanine is selected.  

7. Color the selected isolated alanine violet and label it by symbol. 

8. R-click in an empty area to deselect the isolated alanine. 

 

c. Superposing Molecules 

When a system includes at least two molecules, as in this example, 

HyperChem can superpose the molecules. Superposition is based on the 

selection of three non-collinear atoms in each molecule. To begin, the first 

selected atoms of each molecule are made coincident. Next, the bonds 

between the first and second selected atoms of each molecule are made 

collinear. Finally, the third selected atoms of each molecule are put in the 

same plane. 

To perform the superposition: 
1. Get into selection mode, set the select level to atoms and turn Multiple 
Selections on. 
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2. L-drag the N-C -C ’bond angle of each molecule. You might have to 

rotate the structures to do this. 

 

 
 

3. Choose Overlay on the Display menu. 

4. R-click in an empty area to clear the selection. 

5. Press the space bar to center the superposed structures in the workspace. 

The current system should now look similar to this: 

 

 
 

6. Choose Save As on the File menu and save the superposed molecules as 

ala-sup.hin. What is the effect of the solvent on the optimized geometry? 
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Which parameters can be compared between the two structures? and which 

cannot? 

 

 

Section 4 

 
Molecular Dynamics 

Here you use molecular dynamics to anneal the system to obtain a lower 

energy minimum. You must first retrieve the solvated alanine zwitterion 

system to perform molecular dynamics with it. 

 

a. To retrieve the solvated system: 
1. Open the file ala_sol_opt.hin. 

2. If necessary, turn on Show Periodic Box to display the periodic box you 

defined earlier.  

3. If necessary, remove labels from the display. 

 
b. To set up the dynamics simulation: 
1. Choose Molecular Dynamics on the Compute menu. 

The Molecular Dynamics Options dialog box lets you set the options for a 

molecular dynamics calculation. Take a moment to look at the options.  

 

 
 

A dynamics run for simulated annealing has three optional phases: heat, run, 

and cool. 

In the heat phase the system is brought to the desired temperature by 

rescaling the velocities. The starting temperature is used to set initial 
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velocities, then, rescaling of velocities is done gradually, with temperature 

increments, until simulation temperature is reached. This is the start of the 

run phase, a standard run that can be done at constant temperature (by 

occasionally rescaling velocities) or constant energy.  

The final cooling phase the temperature is brought down by rescaling of 

velocities at temperature increments until the desired final temperature is 

reached. (The cooling phase is required for stimulated annealing, not done 

here)   

2. Set the Heat time to 0.1 picoseconds. 

3. Set the Temperature step to 30K. 

Because the gradient is very small in the starting system (corresponding to a 

near-zero temperature),a short heat time of 0.1 picoseconds is used to raise 

the temperature from a starting temperature of 100 K to the simulation 

temperature of 300K incrementing by a temperature step of 30K. 

4. Set the Run time to 0.5 picoseconds. 

The temperatures are used here to set up initial atom velocities or to adjust 

atom velocities. This kinetic energy might be converted into potential energy 

during simulation, causing the calculated temperature to drop. If the 

temperature eventually rises (as it does in this example),it means that 

potential energy is being converted into kinetic energy as the system moves 

to a more stable conformation. 

5. Make sure the Periodic boundary conditions option is on. This option is 

automatically turned on by HyperChem when periodic boundary conditions 

are used, but it can be overridden by selecting In vacuo. 

6. Set the Step Size to 0.0005 picoseconds. 

7. Set the Data Collection period to 4. 

For systems such as this that have explicit hydrogen atoms, a 0.5 fs step size 

is appropriate for accurately integrating the hydrogen stretching motion. You 

can update the screen at any number of time steps to display real-time 

molecular dynamics. 

8. Turn Constant Temperature off. 
9. The settings in the dialog box should look like this: 
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c. Setting up Playback Dynamics 

The next step is to set up playback dynamics. Playback dynamics is 

convenient because it saves the trajectory – a sequence of configurations at 

successive time points so you can analyze the time evolution later. 

Molecular dynamics simulates the evolution of a system over time, 

producing a trajectory of atomic positions and velocities. These calculations 

can be very time consuming, and for statistically meaningful results, long 

simulation times corresponding to many thousands of time steps might be 

required. 

Often you’ll want to save the calculated trajectory for later play-back or 

analysis, rather than having to repeat the simulation. 

To set up playback dynamics: 
1. Choose Snapshots at the bottom of the Molecular Dynamics 

Options dialog box. 

The Molecular Dynamics Snapshots dialog box opens. 

2. Enter ala_MD_run as the filename. 

HyperChem generates two files with the prefix ala-run. 

One file, ala-run.hin, is a HIN file that contains a snapshot entry.  

Another file, ala-run.snp, is a binary file containing atomic coordinates and 

velocities. 

3. Use a Snapshot period of 1 data step. 

4. Choose OK to return to the Molecular Dynamics Options dialog box. 

 

NOTE: To playback a trajectory that has been stored in a snapshot file you 

must first read the appropriate HIN file unless you have already 

saved snapshots with the current system. When reading the HIN 

file a warning will be issued that the attached SNP file is only valid 

if the molecular system in the HIN file is not edited in any way. 
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That is, the attached *.snp trajectory applies only to the molecular 

system as it is currently constituted. Any editing of the molecular 

system such as deleting an atom, etc. will gray the playback 

option, making it inaccessible. It is possible, however, to change 

the view of the system, define new named selections, etc. as long 

as its atomic information is not altered. 

 

d. Setting up Averaging from Molecular Dynamics 

Molecular dynamics is often used to obtain macroscopic information by 

sampling a microscopic simulation over a long period of time.  

It is also useful to track energetic and geometric quantities as the simulation 

proceeds to see if the system has stabilized enough for sampling to be 

statistically valid or not. 

Note: When you start the Averaging function, HyperChem creates a file 

with the extension .csv in the current working directory.  

 
To set up averaging: 
1. Choose Averages to open the Molecular Dynamics Averages dialog box. 

 

 
 

2. L-click on EKIN, EPOT, ETOT, and ncco in the Selection box, then L-

click on Add to move them to the Average only box. 
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3. L-click on EKIN, EPOT, ETOT, and ncco in the Average only box, 

then L-click on Add to move them to the Avg.&graph box. 

 

 
 

This specifies a plot of total energy, potential energy, kinetic energy, and the 

N-C -C’-O torsion angle you saved as a named selection earlier. 

HyperChem generates a file named ala-run.csv (or chem.csv if playback 

dynamics is not set up), which records the quantities being averaged in a 

format that can be easily read by plotting or spreadsheet programs for 

analysis. 

 

e. Proceeding with Dynamics 

1. Choose OK to return to the Molecular Dynamics Options dialog box, then 

choose Proceed to start dynamics. 

A graph titled Molecular Dynamics Results opens on the work-space. 

2. Move the graph so that you can watch the simulation. 

While the calculation is running, you can change the view of the system by 

using the rotation, translation, zoom, and clip tools. You can also use 

applications in other windows, but this can slow down the simulation. 
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3. As the simulation continues, choose Rescale to rescale the values being 

plotted. 

Once the heating phase is finished, (when energy is being added) the total 

energy remains constant, and the kinetic energy mirrors the potential energy. 

Caution: You cannot recover the plot if you L-click on Done. To recover 

the plot, you must use replay dynamics. 

In the early part of the run after heating, the potential energy and 

temperature should be fairly stable, but then the system temperature rises. 

The potential energy during the run eventually drops significantly. The 

molecular dynamics at room temperature lets the system surmount energy 

barriers on the potential surface and find regions of lower potential energy 

that would not be reached by a minimization algorithm. 

4. When the dynamics run has completed, plot the averages graph and report 

the total energy. 

 
 

5. Clear the window and reload the starting structure (ala_sol_opt.hin). 

Run MD using the same parameters, this time choose in the Molecular 

Dynamics Averages Selection EKIN, EPOT, ETOT and TEMP. 

6. Plot the averages graph.  

7. Compare with the previous graph. Are the total energy and temperature 

conserved?  Discuss the nature of the simulation. 

8. according to the ncco torsion curve, has the simulation converged? 

 

 

f. Reoptimizing the New Structure 

1. Now that the dynamics run is finished, you can optimize the structure to 

determine a new local minimum using Geometry Optimization on the 

Compute menu. (Set the Molecular Mechanics Optimization parameters as 

in section 1.) 

After the optimization finishes, the status line shows a structure that can 

have lower energy than the solvated local minimum found earlier. 
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2. Report the energy and gradient. 

3. Delete the water molecules 

4. Measure and report the geometry parameters. 

The results demonstrate that molecular dynamics can be used to reach 

thermodynamically favored conformations separated from the starting 

conformation by energy barriers. Thus molecular dynamics can be used to 

explore conformational space. 

Such sampling should begin once the system has been equilibrated, often 

judged by kinetic and potential energies fluctuating about consistent values 

for a long period of simulation. 

 

 

Section 5 

 
Langevin and Monte Carlo Simulations 

In this section you use Langevin and Monte Carlo simulation methods to 

further explore conformations of the alanine zwitterion system. The 

Langevin Dynamics method simulates the motion of molecules subjected to 

random collisions and frictional forces and can be used to model solvated 

systems without explicitly including solvent molecules. It provides 

information on the time evolution of the molecular system. The Monte Carlo 

method is used to simulate equilibrium properties. 

 

Part 1: Langevin Dynamics 

A Langevin Dynamics simulation is set up in much the same way as a 

Molecular Dynamics simulation, with small differences due to the addition 

of the friction coefficient. 

1. Retrieve the gas phase alanine zwitterion, which you saved as 

ala_vac_opt.hin, adjust Force Field Options for vacuum as in section 1. 

2. Choose Langevin Dynamics on the Compute menu and set the Langevin 

Dynamics Options as the Molecular Dynamics Options in the preceding 

Exercise. 

3. Set the Friction coefficient to 0.05 ps -1. 

When the friction coefficient is set to zero, HyperChem performs regular 

molecular dynamics, and one should use a time step that is appropriate for 

that method. With larger values of the friction coefficient, motions that occur 

over a short time are less important and larger time steps can be used. 

4. Set the Step size to 0.001 picoseconds. 

The settings in the dialog box should look like this: 
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5. Set up Averages (select EKIN, EPOT, ETOT and TEMP) and 

Snapshots as in the preceding exercise. 

6. Choose Proceed to start the Langevin Dynamics simulation. 

7. Plot the averages graphs and report the total energy. 

8. clear the window and reload the starting structure (ala_opt_vac.hin).  

Setup LD using the same parameters with a different seed number.  

Set the Averages (select EKIN, EPOT, ETOT and TEMP).  

9.Plot the averages graphs. 

10. Compare to the previous graph. Has the simulation terminated with same 

energy values? Is it a deterministic or a stochastic run? 

11. Do you observe both the EKIN and the TEMP curves? Why? What is the 

temperature curve equal to? 

Note: In order for the temperature of a system to be defined, the system must 

be in thermodynamic equilibrium. When two systems are in thermal 

equilibrium and the net heat transferred between them is zero, they have the 

same temperature 

12. (bonus) Were the energy and temperature conserved? Which ensemble is 

it (NVT, NVE, ...)? Explain. 

 

13. Reoptimize the structure, report the energy and gradient, measure and 

report the geometry parameters. 

As with the Molecular Dynamics technique, heating and cooling phases may 

also be added to a Langevin dynamics simulation. 

14. Compare the energy and geometry to that of the starting structure 

(ala_opt_vac.hin). 

 

http://en.wikipedia.org/wiki/Thermodynamic_equilibrium
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Equilibration of the system is not crucial for locating additional low-energy 

structures, but it is important when comparing simulated values with 

experimental properties. 

 

Part 2: Monte Carlo Simulation 

The Monte Carlo method samples configurations from a Boltzmann-

weighted distribution at a given temperature. At elevated temperatures, this 

technique may be used to move the molecular system of interest across 

potential energy barriers. In this exercise we employ the Monte Carlo 

method followed by geometry optimization as an additional conformational 

search technique. 

 

a. To set up the Monte Carlo simulation: 

1. First retrieve the solvated alanine zwitterion system, which was saved as 

ala_sol_opt.hin, adjust Cutoffs and Dielectric Options for solution as in 

section 2. 

2. Choose Monte Carlo on the Compute menu. 

The Monte Carlo Options dialog box allows you to set up the Monte Carlo 

simulation parameters. In this example we will run a constant temperature 

simulation with 1000 steps. For some systems, it may be useful to add 

optional heat and cool phases. 

3. Set the Run Steps to 1000.Set Heat and Cool steps to 0. 

4. Set the maximum step size, Max Delta, to 0.05 Å. 

This sets the maximum trial atomic displacement. If it is too small only 

limited sampling of new configurations will occur. 

If it is too large, unphysical configurations may be generated. 

This reduces the efficiency of the simulation. 

5. Set the Simulation Temperature to 300K. 

6. Make sure that Periodic boundary conditions is on. 

7. Set the Data Collection period to 4 steps. 
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b. Setting up Monte Carlo Playback 

Set up a snapshot file, if desired. 

Playback of the Monte Carlo “trajectory” is set up in the same way as 

Dynamics playback. As with Dynamics, analysis of the simulation may be 

conveniently carried out at playback. For example, you can stop the 

playback at the point in a simulation where the potential energy falls, and 

save the structure at that point. You can also change the graphing and 

averaging selections before playing back a run. 

 

c. Setting up Averaging from Monte Carlo 

Set up Averages and Graphing as desired. 

The Monte Carlo Averages setup is identical to Molecular Dynamics 

Averages setup. There is an additional parameter that you can monitor in 

Monte Carlo:the acceptance ratio. It appears as ACCR on the list of possible 

selections in the Monte Carlo Averages dialog box; DACCR, the rms 

deviation of ACCR from its mean, appears also. The acceptance ratio is a 

running average of the ratio of the number of accepted moves to attempted 

moves. Optimal values are close to 0.5.Varying the step size can have a 

large effect on the acceptance ratio. 

1. Choose Proceed to start the Monte Carlo simulation. 

2. Choose Monte Carlo on the Compute menu, open the Monte Carlo 

Averages dialog box. Average values may be conveniently retrieved by L-

click on one of the properties previously selected for averaging; the average 

value is reported just below.  

3. Report the average total energy (ETOT). 

4. Was the energy conserved? Why? 

 

5. Reoptimize the structure, report the energy and gradient 
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6. Delete the water molecules, measure and report the geometry parameters. 

7. Adjust Force Field Options for vacuum as in step 1. Reoptimize the 

structure, report the energy and gradient, measure and report the geometry 

parameters. 

 

Summarized you results: 

1. Tabulate the energy and geometry parameters of all the minimized 

structure (sections 1-5). Compare between the structures. Which 

comparisons are valid? 

2. How many local minima did you find for the gas phase and how many for 

solution?  

3. What is the main difference between the optimal geometries? 

4. What are the differences between the methods being used in this lab? 

5. What is the significance of the temperature in all the above methods? 

 

Advanced Exercises 

1. Follow these steps to view playback dynamics: 

•Open the file ala_MD_run.hin. 

•Open the Molecular Dynamics Options dialog box and choose Playback 

(at the bottom to the right). Choose Snapshots to determine which part of 

the simulation to replay. 

•Choose Proceed to start playback dynamics. 

The simulation will playback substantially faster then the initial dynamics 

calculation. 

2. Create named selections for two, three, or four atoms, and use playback 

dynamics to plot the values. 

 


